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MULTIMEDIA AND THE NEW TECHNOLOGY IN ELT


CREATING A POWERPOINT PRESENTATION

OPENING POWERPOINT

1. Open PowerPoint.  You will be presented with a choice of different ways of creating a presentation.  Select Blank Presentation and click OK.  When you are asked to choose an autolayout, choose the blank slide in the bottom right-hand corner, and click OK.

If you already have PowerPoint open, click on the white page icon on the toolbar to open a new presentation.  As above, when you are asked to choose an autolayout, choose the blank slide in the bottom right-hand corner, and click OK.

You should now have a blank slide on your screen

ADDING THE TEXT

2. Select Outline View.  You can do this either by clicking on View, and selecting Outline, or by clicking on the 2nd icon from the left in the bottom left-hand corner of the PowerPoint screen.

You are now ready to type in all the text of your presentation.  For the sake of this exercise, I would like you to re-create my presentation.  This is  because I do not want you to spend time thinking of your own text and searching for your own graphics - you will get a chance to do this if you create a PowerPoint presentation in your own time.

Type in the word "CHILE"  (in caps) and press Enter.  You will see that PowerPoint has automatically started a second slide.  On the left of your screen, click on the small green arrow which points to the right.  This will make your next line a bulleted sub-point of your first line.  At this stage, ignore the bulleting, and just continue to enter the text by typing "A country I'd like to visit".  Press Enter again and enter the final bit of text for this slide which is "By Your Name".  

Now press Enter again, but this time, on the left hand side of the screen, click on the small green arrow which points to the left.  This should now start a new slide.  You can now start to enter the text of the second slide.

Save your document by clicking on the floppy disk icon on the toolbar (and remember to keep saving your document regularly as you create your presentation.).  For the moment, save your file on your folder and call it PPT Your Name, eg PPT Luisa.

Continue in this way until you have entered ALL the text for the entire presentation, ie 7 slides.  Remember, at this stage formatting is not important - you are simply entering all the text so that we can then focus on formatting in the next stages.

Here is the text you should enter:

Slide1 

CHILE

· A country I'd like to visit

· By ….
Slide 2

Summary
· Map

· Facts and figures

· Why I’d like to visit

· Photos

Slide 3

Map

Slide 4

Chile: facts and figures

· Capital city: Santiago 

· Population: 15 million (ČR 10.3m)

· Area: 756,950 sq km (ČR 78,864 sq km) 
· Language: Spanish, Aymara, Mapuche and Rapa Nui 

· GDP per head: US$12,500 (ČR US$11,300)

· Major industries: Copper, fishmeal, wine

Slide 5

Why I’d like to visit

· Wildlife

· National parks

· Skiing

· Wild coastline

· Spanish-speaking

Slide 6

Photos

Slide7

The End!

Once you have entered all the text you are ready to begin the task of formatting and animating your presentation.

CHOOSING A LAYOUT FOR SLIDE 1

3. First of all, you are going to choose a layout for the first slide.  Scroll up to the top of text you have inputted, click on Slide 1 and change to Slide View.  (To do this, you can click on View, and then Slide, or just click on the 1st icon in the bottom left hand corner of your screen).  As this is going to be the title slide of our presentation, click on the Slide Layout icon on the toolbar (or click on Format, Slide layout), click on the Title Slide layout, which is the one in the top left-hand corner (note that the title of this layout shows in the box on the right) and click on Apply.

CHOOSING A DESIGN FOR ALL THE SLIDES

4. Now you are ready to select a design for your slides and for this you are going to use one of the designs PowerPoint provides for you.  Click on the Apply Design icon on the toolbar (or Format, Apply Design).  Experiment by clicking on the different designs provided and finally click on Dad's Tie which is the design we are going to use here.  Click on Apply and you will be returned to your first slide.  (You will notice that the "tie" is horizontal - this is because this is the title slide.  In all the other slides, the tie will be vertical).

CHANGING THE FORMAT OF SLIDE 1

5. Let's now make Slide 1 look like it does in the picture below, by moving the text around a little.  

Slide 1

[image: image1.wmf]A country I’d like to visit

CHILE


Font size 54

Font size 40

Font size 32

To do this, first make sure you have slide 1 on your screen in Slide view.  Click anywhere on the word Chile, make it bold and then click on the centring icon.  Next, click on "A country I'd like to visit, change the font size to 40 and centre it too.  Move "By ….." to the bottom of the text box by pressing Enter 2 or 3 times, and then right align it.  Leave the font size at 32.  Note that, if necessary, you can also move the text boxes themselves to re-position text on the slide.

CHANGING THE FORMAT OF SLIDES 2-7

6. You now need to change the layout and text/graphic positioning of the remaining slides so that they appear as in the picture of each slide.  I have provided extra instructions as necessary.

Slide 2

Layout: Bulleted list
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Slide 3
[image: image3.wmf]Map

Layout: Text & clip art

Font size 54

To create this slide, first change the layout to Text & clip art.  Delete the text box on the left, by clicking once in the box, then once on the border of the box and then pressing the delete key.  This leaves you with a title and space for a graphic.  Click on the Insert menu, select Picture, and then From File.  Find the correct picture for this slide on your hard disk (I have provided all the pictures for this PowerPoint presentation on the shared drive), click on Insert and it should appear on your slide.  Drag it into the space for the graphic and it should automatically be resized.  Finally, change the shape of the text box containing the word "Map", and drag it into the correct place on the slide.  Then enlarge the map and drag it to where it should be on the slide.  (NB You could also create this slide by starting with a blank slide, inserting the picture and then creating a text box for the word "Map" - see procedure for Slide 6.)

Slide 4

Layout: 2 column text

Font size 54

[image: image4.wmf]Chile: facts and figures

n

Capital city:

 Santiago

n

Population:

 15 million

(

Č

R 

10.3m)

n

Area:

 756,950 sq km

(

Č

R 

78,864 sq km)

n

Language:

 Spanish,

Aymara, Mapuche and

Rapa Nui

n

GDP per head:

US$12,500

(

Č

R 

US$11,300)

n

Major industries:

Copper, fishmeal, wine


Font size 24
Once you have changed the layout of this slide, you will need to drag some of the text from the column on the left into the column on the right by highlighting it and then dragging it.  (I have increased the size of this graphic so that you can read the text more easily.)

Slide 5
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As you can see, I have also added a sound file to this slide, which is shown by the sound file icon.  To add a sound file, click on Insert, Movies and Sounds, Sound from File.  Go to the shared drive for the birdsong sound file I have provided and click on OK.  The sound file icon will appear on the screen and you can move it to the correct position on the slide.

Slide 6
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To create this slide, change the layout to Blank.  Then insert the three photos by using the Insert menu as you did earlier to insert the map into Slide 3.  To insert the text, click on the Insert menu and choose Text Box and type in the word "Photos".  Change the font size to 54 and move the box to the correct position.  Repeat this procedure to create the captions.

Slide 7
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ADDING SLIDE TRANSITIONS

7. Change to Slide Sorter view by clicking on View and selecting Slide Sorter (or by clicking on the Slide Sorter icon - 4 little boxes - in the bottom left-hand corner of the screen).  You should now be able to see all your slides. Click on the first slide, then click on the Slide Show menu and choose Slide Transition.  Choose Cover Right, medium, and Apply to All.

We will use this slide transition for all the slides, except the first one.  So now click on the first slide again, click on Slide Show menu and choose Slide Transition again.  Select Box Out, Slow, and this time click on Apply instead of Apply to All, so that this transition will only apply to the first slide.

If you click the little slide icon under each slide on the left, you will see a preview of the slide transition.

ANIMATING THE SLIDES

8. Change back to Slide view so you can see each slide one at a time.  Scroll down to Slide 3 (Map) as we are not going to animate the first 2 slides.  Click on the Slide Show menu and choose Custom Animation).

First of all, make sure you are on the Timing tab.  Then click on the object you wish to animate (which is the title in this case) and choose Animate.  You will see that it jumps into the box above, called Animation Order box.

Now click on the Effects tab.  Click on the item (probably called "1. Title 1") in the Animation Order box and you should see a box appear around the word "Map" on the slide on the right.  Choose Stretch Across and click Preview.  Finally click OK.

9. Now move on to Slide 4 (Chile Facts and Figures).  This time, you need to animate 2 objects (probably called Text 2 and Text 3), ie the bulleted list on the left and the bulleted list on the right.  Proceed as before but for the left hand list choose Fly from Left and in the After Animation box at the bottom, click on the arrow and choose the light blue colour.  

For the right hand list, choose Fly from the Right and again the light blue colour for after animation.  Check your work by clicking on the Preview button.  Click OK.

10. Slide 5 (Why I'd like to visit).  Animate the list in slide 5, choosing Fly from bottom right, and Hide on Next Mouse Click after animation.

11. Slide 6 (Photos).  I have used both visual and audio animations in this slide.  Please choose your own from the selection.  (For interest, my animations are: Tatio picture - spiral, sound = whoosh; Tatio caption - Fly from left, sound = drumroll, by word; Guanaco picture - peek from right, sound = whoosh; Guanaco caption - Fly from left, sound = typewriter, by letter; Volcano picture - split vertical out, sound = whoosh; volcano caption - Fly from left, sound = explosion.)  

Note that you can change the order in which each item appears on the slide by clicking on the up and down arrows next to the Animation Order box once you have specified which objects you want to animate.

12. Slide 7 (The End).  Animations are Dissolve and Clapping.

VIEWING YOUR PRESENTATION

To watch your presentation, scroll up to Slide 1 in Slide View (or click on Slide 1 in Slide Sorter View) and then click on the Slide Show icon in the bottom left-hand corner of your screen (or click on Slide Show menu and choose View Show).

ADVANCED TOPICS

If you have used PowerPoint before and would like to explore some of the more advanced features, here are some ideas:

· Duirng the presentation, right click on the screen and explore the Pen and Pointer options and the button.

· On the Slide Show menu, explore Rehearse timings, record narration, Set up Show, Action buttons. Hide Slide.

· Print Options: Click on File menu, then Print and click arrow by Print What:, plus experiment with options below Print What such as frame slides, etc.

WHERE TO FIND FACTS AND FIGURES AND PHOTOS

· http://www.lonelyplanet.com/destinations/  Lonely Planet

· http://www.google.com Use the Images facility to search for suitable photos
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Chile: facts and figures



		Capital city: Santiago 

		Population: 15 million (ČR 10.3m)

		Area: 756,950 sq km (ČR 78,864 sq km) 



		Language: Spanish, Aymara, Mapuche and Rapa Nui 

		GDP per head: US$12,500                (ČR US$11,300) 

		Major industries: Copper, fishmeal, wine
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